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Warranty and Liability

Warranty and Liability

Note

The Application Examples are not binding and do not claim to be complete
regarding the circuits shown, equipping and any eventuality. The Application
Examples do not represent customer-specific solutions. They are only intended
to provide support for typical applications. You are responsible for ensuring that
the described products are used correctly. These application examples do not
relieve you of the responsibility to use safe practices in application, installation,
operation and maintenance. When using these Application Examples, you
recognize that we cannot be made liable for any damage/claims beyond the
liability clause described. We reserve the right to make changes to these
Application Examples at any time without prior notice.

If there are any deviations between the recommendations provided in these
application examples and other Siemens publications — e.g. Catalogs — the
contents of the other documents have priority.

We do not accept any liability for the information contained in this document.

Any claims against us — based on whatever legal reason — resulting from the use of
the examples, information, programs, engineering and performance data etc.,
described in this Application Example shall be excluded. Such an exclusion shall
not apply in the case of mandatory liability, e.g. under the German Product Liability
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life,
body or health, guarantee for the quality of a product, fraudulent concealment of a
deficiency or breach of a condition which goes to the root of the contract
("wesentliche Vertragspflichten”). The damages for a breach of a substantial
contractual obligation are, however, limited to the foreseeable damage, typical for
the type of contract, except in the event of intent or gross negligence or injury to
life, body or health. The above provisions do not imply a change of the burden of
proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts
hereof is prohibited without the expressed consent of Siemens Industry Sector.
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1 Automation function

1.1

Automation function

Description of the functionality

The SINAMICS G120 drive inverter is a modular inverter system with degree of
protection IP20. It comprises the two function units Control Unit (CU) and Power
Module (PM).

When using the Control Unit CU240S PN, you have the possibility to use the
PROFINET IO interface. This interface can be used for data exchange between
inverter and control and to run the drive with the control.

SINAMICS G120 (CU240S PN), Control via PROFINET
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2 Functionality of the function example

211

2.1.2

2.2

Functionality of the function example

Task description

The SINAMICS G120 is to be controlled from an S7-300 CPU via Profinet.

Solution

In this function example, the control of a SINAMICS G120 (control word and
frequency setpoint) will be demonstrated using an S7-300 CPU and a specific
program example.

This program example comprises an S7 program to control the SINAMICS G120
and the appropriate configuration in the SINAMICS G120.

Structure of the function example

¢ In Chapter 3 the required hard and software components for the function-
examples are shown.

e The download and test of the program examples supplied are described in
Chapters 4 to 5.

e Chapter 6 informs about the key performance date.

¢ In Chapter 7 more detailed information are delivered. These Steps are not
necessary for the commissioning of the function-example and you don’t have
to do these because they are already included in the S7-Program and
accordingly the SINAMICS G120 Project. The given information should help
you with the creation of your own projects.

SINAMICS G120 (CU240S PN), Control via PROFINET
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3 Components that are required

3 Components that are required

An overview of the hardware and software components required for the function
example is provided in the Chapter.

3.1 Hardware components
Component ‘ Type ‘ Order No./ordering data ‘ Qty ‘ Manufacturer
S7 control
Power supply PS307 5A 6ES7307-1EA00-0AAQ 1 SIEMENS
S7-CPU CPU 315-2 PN/ DP 6ES7315-2EH13-0AB0 1
Memory Card MMC 512 KB 6ES7953-8.J11-0AA0 1
DI / DO simulation module SM374 6ES7374-2XH01-0AA0 1
Profile rail Profile rail 6ES7390-1AE80-0AAD 1
PROFINET RJ45 connector * PROFINET connector 6GK1901-1BB10-2AA0 4
PROFINET cable PROFINET cable 6XV1840-2AH10 5m
Drive
SINAMICS G120 Control Unit CU240S PN F (FW3.2) 6SL3244-0BA21-1FA0 1 SIEMENS
SINAMICS G120 Power Module | PM240 6SL.3224-0BE21-5UA0 1
Basic Operator Panel BOP 6SL3255-0AA00-4BA1 1
Motor Three-phase induction 1LA7060-4AB10 1
motor
Note The functionality was tested with the specified hardware components.
Similar components that are different from those listed above can be used.
Please note that in such a case it may be necessary to change the code
example (e.g. setting other addresses).
3.2 Software components
Component Version Order No. / ordering data Qty Manufacturer
SIMATIC STEP 7 Vo SPS* | 6ES7810-4CC08-0YAS SIEMENS
V4.1 + SP5 + | http://support.automation.siemens.com/
STARTER HF1 WWiview/en/26233208
. http://support.automation.siemens.com/
GSDML-File CU240S PN V3.2 WWiview/en/26641490
SINAMICS G120 (CU240S PN), Control via PROFINET
V1.0, Beitrags-ID: 45287261 7
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4 Configuration and wiring

4 Configuration and wiring

The hardware configuration and connecting-up the function example are described
in this Chapter.

Please carefully observe the following safety information & instructions when using
the SINAMICS G120:

The SINAMICS G120 has hazardous voltages and controls rotating mechanical
parts that can also be potentially hazardous. If the warning information is not
observed or the information & instructions from the instructions belonging to
SINAMICS G120 are not complied with this could result in death, severe bodily
injury or significant material damage.

4.1 Overview of the hardware configuration

CPUI5  gpary
-2PNDP

P330T

230V
SIHAMICS G120

Profinet

400V

SINAMICS G120 (CU240S PN), Control via PROFINET
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4.2 Connecting-up the hardware components
42.1 S7-300 control and CU240S PN
PSa07 CPU315-2 PN/DP SMaT4
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4.2.2 PM240 and motor

L1
L2
L3

PE

SINAMICS G120
PM240

PE L N w1 u2 V2 w2 PE
Ul V1 L3
L1 L2

For more detailed information regarding the installation please refer to the SINAMICS G120 Hardware Installation Manual Power
Module PM240. Download from: http://support.automation.siemens.com/WW/view/en/22339653/133300

SINAMICS G120 (CU240S PN), Control via PROFINET
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4 Configuration and wiring

4.3

4.4

441

Fault 395 (acceptance test / acknowledgement present)

Fault F395 is output when powering-up for the first time and after replacing the
Control Unit (CU) or the Power Module (PM).

This fault does not represent an incorrect drive inverter function. The reason for
this fault message is to monitor the individual drive inverter components (CU and
PM) to prevent them from being replaced by unauthorized personnel.

Acknowledging fault F395

Just like any other fault, it can be acknowledged using an appropriately
parameterized input, via the field bus or using the STARTER parameterizing
software.

Important hardware component settings

Most of the module/board settings are made in the HW Config in the software.
Hardware settings are only required for the following modules/boards.

The modules/boards must be set with the control system in a no-voltage state.
SM374 simulation module

This module can be operated as 16 x DO (output via LED), 16 x DI (input via
switch) or as combined 8 x DI / 8 x DO. The last combination is used in this
function description.

The function of the module is selected using a rotary switch behind the front cover
between the series of switches.

As shown in the following diagram set the function switches to the setting 8 x
Output 8 x Input.

By k’lfn}:[lu’rput
Outpu

fx
Inpud riIE.xlnpuT
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4 Configuration and wiring

4.5

Overview of inputs and outputs

451 Simulation module SM374
(o]
5 0 | —O00berror
5 —
m 1
o] 2
o] 3
o &
I
6] &
6] 7
Ry k‘lﬁ:ﬂufuut -
Qutpu
By
'"ﬁ“* r1E|:|:I|1|:aur _
@ 0 1 0.0 SIHAMICS G120 start
=]
@ i 1 6.1 SIHAMICS G120 reverse
o] 2
SRR
) B 4
@ i Fr 10.5 Increase frequency
@ o —f 10.6 Decrease frequency
o | @ . 1. T Acknowledge error
0 1 |[F
Address Function Symbolic address | Default Explanation
00.0 Indicator lamp error 0 faults are signaled via this output
error
10.0 SINAMICS Start_G120 0 The motor connected_ to _SINAM!CS G120 is started by
G120 start activating the input
SINAMICS After the input is activated, a negative frequency
10.1 G120 reverse Reverse_G120 0 setpoint is entered (direction of rotation reversal)
10.5 Increase Increase_frequenc 0 The motor frequency can be increased using this input
) frequency -Ireq Y q y g P
10.6 fDecrease Decrease_frequency 0 The motor frequency can be reduced using this input
requency
107 Acknowledge ACK error 0 Fault messages that are prgse_nt can be acknowledged
error - using this input.
SINAMICS G120 (CU240S PN), Control via PROFINET
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4 Configuration and wiring

45.2 SINAMICS G120
The SINAMICS G120 is controlled and the feedback signals read-in via the I/O
addresses listed below.
Address Function
S7 program -> SINAMICS G120
PQW256 Control word 1
PQW258 Frequency setpoint
PQW260 Torque setpoint
PQW262 Control word 2
PQW264 -- Reserve --
PQW266 -- Reserve --
SINAMICS G120 -> S7 program
PIW256 Status word 1
PIW258 Frequency actual value
PIW260 Current actual value
PIW262 Status word 2
PIW264 Last fault number
PIW266 Last alarm number

For more detailed information about the configuration of the individual signals,
please refer to SINAMICS G120 Operating Instructions Control Unit CU240S,
Chapter Commissioning.

Download from:
http://support.automation.siemens.com/WW/view/en/22339653/133300

SINAMICS G120 (CU240S PN), Control via PROFINET
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5 Download

Download

S7 program

To download the S7 program, you will require a connection between the MPI
interface of your PG/PC and the MPI interface of the S7 CPU.

14

Start the SIMATIC Manager.
De-archive the function example supplied.
Open the G120_STD_APP2 project.

Select the MPI interface parameterization using Options > Select PG/PC
interface... .

Open HW-Config and download this into the control. After the download re-
close HW-Config.

In SIMATIC Manager, select the block folder via CPU315-2 PN/DP > S7
Program > Blocks.

Download all of the S7 program blocks into the CPU

SINAMICS G120 (CU240S PN), Control via PROFINET
V1.0, Beitrags-ID: 45287261
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5 Download

5.2

Setting the SINAMICS G120 IP adresse and device

name

Different than for Profibus, for PROFINET, the node addresses are not set in the

hardware, but in the software. To do this, a connection is required between the
PG/PC and the PROFINET interface of the SINAMICS G120 via TCP/IP.

e To do this, connect the PROFINET cable from the SINAMICS G120, interface
X01 P2 to the Ethernet interface (port) of your PG/PC (refer to Chapter 4.1).

e Setthe IP address and the subnet mask of the Ethernet card of your PG/PC as
follows.

Advanced  Help

@Back - \J IT /'_F) Search [{_" Folders | |z [3% x n

Address |e} Network Connections

LAN or High-Speed Internet

LAN-Yerbindung Drahtlose Netzwerkverbindung
Connected Rot connected
M Inkel(R) PRO100 VE Network ... [ @i Infel(R) PROMIreless 291548, .,

Wizard
‘ Mew Connection Wizard Q Network Setup Wizard
;’ L]

- LAN-Verbindung Properties

General | Advanced |

Connect using:

| 8 IntellR) PRO00YVE Metwark Canne |

This connection uzes the following items:
% PROFINET 10 RT-Protocol 5
T SIMATIC Industrial Ethernet (1I50)
% Internet Protocal [TCPAR)

=
] | @
Install.. Unirstall
Description

Transmission Control Protocol/Intemet Protocol. The default
wide area network. protocol that provides communication
across diverse interconnected netwarks.

] Shaw izon in notification area when connected
Molify me when this connection has imited or no connectivity

SINAMICS G120 (CU240S PN), Control via PROFINET
V1.0, Beitrags-ID: 45287261

Internet Protocol (TCP/IP) Properties IElEJ

General |

You can get [P setings assigned automatically if your network. supports
this capability. Dthervise, you need to azk your network administrator for
the appropriate IP settings.

() Dbtain an IP address automatically

(%) Use the follawing IP address:
IP address: 192 .168. 0 .100

Subnet mask: @l

Default gateveay: |7
Obtain DNS server addiess automatically

(®) Usze the following DMS server addresses:

Frefered DS server. |7|

Altemate DNS server: |7|

15
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e Using Options > Set PG/PC Interface.... select the TCP/IP interface
parameterization. You can carry out all additional steps via this interface during
the course of the function example.

S5et PG/PC Interface El
Access Path }

Access Point of the Application:

| [

[Standard far STEP 7)

|nterface Parameter Azsignment Uzed:

|T|:F'.-"|F' -» |ntel(R) PROA00YVE Me... Properties. ..
PC COM-Part [USS] " Diagnaostcs...

PC/PH cable{PPI

BZ TCRAP -» IntellR] PROA 00 VE Ne -]
TCFAR -» Intel[R] PROAwireless . o

< ¥

[&szigning Parameters to vour MDIS CPs
with TCPAP Protocol [RFC-1006])

Interfaces

Add/Remove: Select...
Cancel | Help ‘

e Then, using PLC > Edit Ethernet Node..., open the dialog box Edit Ethernet
Node.

SINAMICS G120 (CU240S PN), Control via PROFINET
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5 Download

e Pressthe Browse... button

Edit Ethernet Node

Ethernet node

Set [P configuration

& Use |P parameters

IP address:
Subnet mask:

(" Dbtain IP address from a DHCP server
|dentified by
{= i

MNodes accessible onling

Gateway
{* Do not use router

™ Use rauter

——

ES)

Client ID: [

Aszign device name

Device name:

Reset ta Factary settings

Cloze

Help

¢ Inthe dialog box that then opens, select the node with the SINAMICS device

type and then press the OK button.

Browse Network - 2 Nodes

3

etune | Device name

Start L1 1P addie [ bdar

|« Fast search

Flash <

MAL address: 05-00-05-3C-CC-AF

Cancel |

Help

SINAMICS G120 (CU240S PN), Control via PROFINET
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5 Download

e (1.) Now, enter under IP-adresse: 192.168.0.2 and under Subnetmask:
255.255.255.0. (2.) Then press the Assign IP Configuration button.

Edit Ethernet Node

Ethernet node

MALC address:

Set [P configuration

3

MNodes accessible online

08-00-08-3C-CC-4F Browse...

* |lze |P parameters

Gateway
IP address:
aoress 132.168.0.2 &+ Do not uze router
Subnet maszk: 255.255.255.0 " Use router
(" Obtain IP address from a DHCP server
|dentified by
{ i i
Clignt ID: [

( Azsign |P Configuration “2.

Azsigh device name

(Device harne:

1.
G120 ] ( Azzign Mame ]

Reszet to factory settings

Cloge

[ s
Help

e (3.) After completing the IP configuration assignment, enter the device name -
assigned in HW Config - under Device name: (in this particular function
example, G120). (4.) This is then assigned to the SINAMICS G120 by pressing
the Assign Name button.

e Close the mask by pressing the Close button.

18
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5 Download

5.3 SINAMICS G120 configuration

When this has been completed, download the SINAMICS G120 configuration using
the STARTER parameterizing tool.

e Starting from the main path of the SIMATIC Manager, start the STARTER
parameterizing software by selecting the SINAMICS_G120 icon and double
click on the Inbetriebnahme icon.

QSIMATIE Manager - [G120_STD_App_2 - C:}Siemens'Step7\s7projiG120_STD]

BpFle Edt Insert PLC View Options Window Help

I BT

=

s | &1 |[ < Mo Fiber> =™

LHE BEM

- G120 5TD_bApp 2 Object name | Type Size | Authar | Last modified | car
= SIMATIC 300(1) Eaiinbeticbnanme Commissioning OBAG/201003.2751 PM )

- =-[@ crums2rnop
i = 57-Programm(3]

{3 Quellen
i-{gg Bausteine

& Bz

e Then, in the Project Navigator of the STARTER parameterizing software select

the object "G120" (1.) and press the button h (2.) to establish the online
connection to the drive inverter.

JSTARTER - G120_STD_App_2 - [6120.5INAMICS_G120 - Configuration]

ﬂ] Project Edit  Target system  Wiew Options  Window Help
DT e e T e o s e 1Y ) S R
T 2

s —————————————————— |
=] % G120_5TD_fpp_2 Drive data set DDS 0 ‘wiizard... |

- Insert single drive unit Command data sst COS 0

o Configuration | Dirive data sets | Command data sets | Reference parameter |

Drrive navigakar
> Configuration
S Inputsfoutputs

-3 Setpoint channel Interfaces

Mame: |S\NAM\CS_G12D Control type:

-3 Opendoopfclosed-loop contraol

[+ % Functions
- Messages and moritoring SINAMICS_G120.Closed-loop contiol moduls Encoder

[~ Technology controller - Tz G120 CLIZ405 P
[+~ Commissioning ] Enc. type:
Order no. B5L3244-0B420-1FAD

» Communication

[ Diagnostics Firmwiare version: 324

e After you have established the online connection, press the button @l to
download the SINAMICS G120 drive parameters.

e Follow the instructions on the screen and acknowledge the prompt "After
loading, copy RAM to ROM".

SINAMICS G120 (CU240S PN), Control via PROFINET
V1.0, Beitrags-ID: 45287261 19



Copyright © Siemens AG 2010 All rights reserved

5 Download

5.4

20

Exiting the STARTER parameterizing software

If you don't wish to set any additional parameters, then you can now exit the
STARTER commissioning tool.

In the tree select SINAMICS G120 and transfer all of the parameter changes
into the ROM memory of the SINAMICS G120 by pressing the .;| button
Then transfer all of the parameters into your offline a project by pressing the

I@ button.

Disconnect the PG / PC from SINAMICS G120 by pressing the |ﬁ| button.

Now you can close STARTER using Project > Close or by pressing the x|
button.

SINAMICS G120 (CU240S PN), Control via PROFINET
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6 Key performance data of the SIMATIC CPU

6 Key performance data of the SIMATIC CPU

Load memory and working memory

Total

Load memory Approx. 6 k

Working memory Approx. 2 k

Cycle time

Total cycle time (typical) Approx. 1ms

Copyright © Siemens AG 2010 All rights reserved
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7 Background information

7.1

Background information

The individual functions of the example code are explained in the following
Chapters so that you will then be in a position to implement your own project.

For this function example, the settings described no longer have to be made.

Settings in the hardware configuration

E{g:HW Config - [SIMATIC 300{1) {Configuration) -- G120_STD_App_2] - |EI|5|
E“] Station  Edit  Imsert PLC  Wiew Options Window Help _|ﬁ||5|

D=2 5 S| e dda B %8 8

[ UR

=[]

PS 307 54 e
CPU 315-2 PN/DP
MEA0R

S

Paf 7

Ethemet[1]: PROFINETH0-5ystem [100°

DI18/D08:DC244 /0,54

mﬂmmhw%%?—}m
o
-l

=
1| | 3

ﬂﬂ [0 UR

Slat Madule O R M | G| Comment

1 1§ PS 307 54 BESY -

2 CPU 315-2 PN/DP |BES{¥2.6

ey ARERATE R

AL R S

AL A7 S|

3

4 |[d pi8/DOBDC24v/054 |BEST oo

5

E —

7

: i
Press F1 ko get Help, v

SINAMICS G120 (CU240S PN), Control via PROFINET
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7.1.1 Properties of the SINAMICS G120

The window of the SINAMICS G120 PROFINET properties (2.) is displayed by
clicking once on the SINAMICS G120 icon (1.).

E—,_'{:Hw Config - [SIMATIC 300({1) {Configuration) -- G120_STD_app_2] - |EI|£|
Eﬂ] Station Edit Insert PLC Miew Options Window Help _|5’|5|

D" & S|ee |dda B B

PS5 307 B4 -
CPU 315-2 PN/DP
MDA

PO

Pt ¥

| i

Ethernet[1]): PROFINET-I0-System [100

D18/D0 8D C24Y/0.54

-1

-
1| | »

ﬂ:l [1] SINAMICS-G120-CU2405

Slot Module Order number | &ddress [ address Diagrostic ... | C... |
£ SINAMECS -G LA K5 7 20050 TFA R S
A FRCFEINET SR
A a7 E
L Far s SY
1 SIEMENS Telegramm 2039
2 £ e D U
A SHEAERS Fatamamm T SEEL LSBT | SRE S I
rl
!']
.
Press F1 bo get Help, [ [ [ 2

The PROFINET telegram (2.) between the CPU and the SINAMICS G120 is the
Standard Telegram, in this particular example, Standard Telegram 352 for the
communications of the SINAMICS G120 (control signals, status signals, frequency
setpoint, frequency actual value etc.)
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The telegram is selected in the Catalog after pressing the button.

Bl=

Find: | ‘"'ﬂ # ,|
&

Prrofile: I Standard

= 2% PROFIBUS DF
- 32 PROFIBUS P4,
=48 PROFINET IO

EI{:I Drives
=0 SINAMICS

SIEMEMS telegram 350
SIEMEMS telegram 352
SIEMEMS telegram 353
SIEMEMS telegram 354
Standard telegram 1

[ Standard telegram 20

£ E SIMAMICS G120 CUZ405 PN F
£ ﬁ SIMAMICS G1200 CU2400 PN

£ ﬁ SIMAMICS G1200 CLZ2400 PH F
- SINAMICS G120

- SINAMICS G130

- SINAMICS G150

- SINAMICS GL1ED

[

[

:l.
H-
].

o7 SINAMICS GM150
b SINAMICS 5120
- SINAMICS 5150
b-[_7] Gatewsay

-2 HMI

g 1/0

1] Network Components
f-_7 Sensors

{1 Switching devices
SIMATIC 300

SIMATIC 400

SIMATIC HI Station
SIMATIC PC B azed Control 3007400
SIMATIC PC Station

[ M rn a ]

]

[l

B EE

L I B e B e
-] [ [

B5L3 244-0BA20-1FAD ﬂ 3
Siemenz: AG =
Device SINAMICS G120 dive with PROFINET 10
functionality (AT, cyclic and acyelic communication]ﬂ

I | [ 4

You can download the GSDML files for the SINAMICS G120 under the following
link: http://support.automation.siemens.com/WW/view/en/26641490

GSD files are required to operate a node (e.g. the SINAMICS G120) on PROFINET
— and to register (log-on) the device to the engineering tool.

SINAMICS G120 (CU240S PN), Control via PROFINET
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7 Background information

7.1.1.1

Standard Telegram

Properties - SIEMENS Telegramm 352 il

General Addreszes |

— Inputz
Start: Process image:
End: IEIB1 Pl 'I
— Dutputs
Start: 256 Process image:
End: 267 [oB1 P =

Cancel | Help |

Various pre-assigned telegrams are available for this communication; these can be
selected from the hardware catalog (refer to 6.1.3).

The Standard Telegram 352 is used in this function example. It contains a length
of 6 words sending (output) and receiving (input) — beginning from starting address
256.
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7 Background information

7.2

7.2.1

Functions of the Step 7 program

Program overview

OB1

CALL FB1D ——

FB10
Organisation

Pravide the
Controbword 1/ 2,
Frequency- and
Torgue Sefpoint

Activation of the
indication lamp
for error

DB1
Auis_DB G120

FC100
Control G120

Read staluswords
out of the G120 and
transfer to the Axis-

oa

Read emor- and
alarmnumber out of
the G120 and
transfer to the Axis-

Read controlwords

aut of the Axis-DB

and transfer to the
G120

The Step 7 program essentially comprises blocks FB10, FC100 and DB1 that are
called in the cyclic program (OB1).

26
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7 Background information

7.2.2

DB1, Axis_DB

The Axis_DB represents the interface between the S7 program and the SINAMICS

G120 via FC100.

Axis_DB is generated from UDT 1 (Axis_DB_G120)

Principal structure of Axis_DB:

Address Symbolic name Type Function
Internal data
DBWO Basic_Data.Moduleadress INT | I/O start address of the SINAMICS G120 (refer to
HW Config)

DBB3 Basic_Data.Drivetyp Byte | Drive type, must be 2

S7 -> SINAMICS G120
DBW4 Control_signals.STW2 Bool | Control word 2 (for details, refer to the S7 program)
DBW6 Control_signals.STW1 Bool | Control word 1 (for details, refer to the S7 program)
DBW8 Control_signals.Frequency_set INT | Frequency setpoint in x.x %
DBW10 | Control_signals.Torque_set INT | Torque setpoint in x.x %

SINAMICS G120 -> S7
DBW14 | Status_signals.ZSW2 Bool | Status word 2 (for details, refer to the S7 program)
DBW16 | Status_signals.ZSW1 Bool | Status word 1 (for details, refer to the S7 program)
DBW18 | Status_signals.Actual_frequency INT | Frequency actual value in x.x %
DBW20 | Status_signals.Actual_current INT | Current actual value (Value from SINAMICS G120)
DBW?22 | Status_signals.Actual_current_A INT | Current actual value in x.xx A

Error messages

DBW24 | Faults.Drive_error_number INT | Actual error number of the SINAMICS G120
DBW26 | Faults.Drive_alarm_number INT | Actual alarm number of the SINAMICS G120

In this function example the individual data of the DB1 are supplied in FB10.

SINAMICS G120 (CU240S PN), Control via PROFINET
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7.2.3 FB10, Organization

This block is called-up in absolute terms in OB1 and in turn calls up FC100.
Principle of the FB10

Network Function

1 Calls the FB11 to generate the frequency setpoint

Controls the SINAMICS G120 via the axis-DB, DB1.

Calls the SINAMICS G120 control block FC100.

2
Provides the feedback signals — incl. error and alarm number
This network can be used as template for additional SINAMICS G120 control functions.
3 Controls the signal lamp for fault.
7.2.4 FC100, Control of SINAMICS G120

SINAMICS G120 is controlled using the FC100 via PROFINET.

Only signals from the Axis_DB are used to control the block - but no fixed
addresses - this is the reason that instances can be used.

This block can be used in the same way for both a standard and a Safety
SINAMICS G120.

Formal operands of the FC100

Formal operands Type Description

Nr_Axis_DB IN Number of the Axis-DB generated using UDT1

Copyright © Siemens AG 2010 All rights reserved

Displays an internal error
Internal_Error ouT 0 =no error
1 = incorrect Axis-DB type (wrong UDT)

Principle structure of the FC100

Network Function
1 Opens the Axis_DB specified using the formal operands Nr_Axis_DB.
Generates the internal error message.
2 Re_ads-in the SINAMICS G120 status words, processes these and saves them in the
Axis_DB.
3 Resets internal error messages.
4 Converts frequency and torque setpoint from the Axis_DB (entered in x.x %) into the

SINAMICS G120 format (hex).

Enters SINAMICS G120 error and alarm number into the Axis_DB.

Sends control words from the Axis_DB to the SINAMICS G120

SINAMICS G120 (CU240S PN), Control via PROFINET
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7 Background information

7.3

7.3.1

SINAMICS G120 parameterization

SIMATIC Manager - inserting SINAMICS G120 ,

¢ In SIMATIC Manager select the tree G120 _STD_App2 and using Insert >
Program > SINAMICS select a SINAMICS G120 type object.

QSIMATIE Manager - [G120_STD_App_2 -- C:\Siemens'Step 7' s7proj\G120_5TD]
@F\Ie Edit | Insett PLC Wiew Options Window Help

D |8 steton vh 5[ i | [N Fier A% BaE BB M
- 5 Subnet 3
= ENl — = '~ mbalic name | Type | Sizel Author | Last modified

e 7 Progran SIMATIC 300 Station 06/30/201012.23.0;
E"" 57 SoftiAre = Program SINAMICS 0E/24/2010 12:05:5¢

i B 57 Block r & [Five MPI 2334 0B/15/2010 03:20:5¢

M7 Software r 5 STNAMICS FROFIBUS 7684 06/23/2010 04:35:5(
E Gl Symbol Table . Industrial Ethem.et 2328 06/30/2010 12:23:00
alez Schiftfeld - Global labeling field 06/15/2010 03:20:5¢

Tiexk Librars: [
Extbzrnal Source, .,

WINEE flexible BT 2
Shared Declarations 3

Farameter -

External parameters, ..

—

e Make the following settings and press the OK button.

Insert single drive unit |

General  Drive Unit A Bus Address |

Device farnily: I SINAMICS j
Lizsioe | SINAMICS G120 =
Device characteristic:

Characteristic | Order no. |

CU230P-2 CAM B5L3 24 3-uummlhulon

CU230P-2 DP BSL3 243-wummlhuPuy

CUZ230P-2 HWAC B5L3 24 3-wumml-uH

CLI240 BSL3 244-mamus-nsus
Wersion; I 27 j
Drline access: IPHDFIBUS j
Address: |-||:| j
Slat: 2 _:l

Cancel | Help |
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7 Background information

7.3.2

7.3.3

Calling the STARTER parameterization tool

e Starting from the main path of the SIMATIC Manager, start the STARTER
parameterization software by selecting SINAMICS_ G120 and double click on
Inbetriebnahme.

HSIMATIE Manager - [G120_Safety_App_2Z_W20 -- C:\Siemens\Step 7 s7proj G120_§ 1]

%Eﬂe Edit Insert PLC View Options Window Help

O |22 4 B idallz 32 o &[] m [ <NoFiher Y| aE 2EMm|

El-E=p G120_Safety_dpp_2 %20 | Objsctname | Symbolic-name | Typ
E‘ SIMATIC 300(1] (5! Inbetiebrahme Commissioring 06/15/2010 032151 PM

- B[ U nse2 PHDP
H E] S7-Programm{3]
{B Suellen
‘(g8 Bausteine

@ G120

b

e Then, in the Project Navigator of the STARTER

parameterization software select the object G120 (1.) and press button E (2.)
to establish an online connection to the drive inverter.

JSTARTER - G120_STD_App_2 - [6120.5INAMICS_G120 - Configuration]

&] Project Edit  Target system  Wiew Options  Window Help

DT e e T e o s e 1Y ) S R

I 2.
s —————————————————— |
=] % G120_5TD_fpp_2 = Drive data set DDS 0 ‘wiizard... |

- Insert single drive unit Command data sst COS 0

Configuration | Dirive data sets | Command data sets | Reference parameter |

Drrive navigakar

~ ) Configuration Mame:  [SINAMICS_G120 i
S Inputsfoutputs
-3 Setpoint channel ’m

-3 Opendoopfclosed-loop contraol
[+ % Functions
[+ Messages and moritoring

[~ Technology controller - Tz G120 CLIZ405 P
[+~ Commissioning ] Enc. type:
Order no. B5L3244-0B420-1FAD

SINAMICS_G120.Closed-loop cantral module Encoder

» Communication

[ Diagnostics Firmwiare version: 324

STARTER - carrying out quick commissioning

e The screen form with the actual configuration is opened by double clicking on
Configuration in the Project Navigator.

e The quick commissioning Wizard is started after pressing the
Wizard. .. button.

e Enter the appropriate values into the Control structure to Encoder screen
forms. You can call-up corresponding help texts in the individual screen forms
by pressing on the Help button.

¢ Inthe screen form Drive functions, select for Motor identification, the
function Ident. of al param. in standstill incl. the saturation curve (3).

e Enter the corresponding parameters into the Important parameters screen
form.

¢ Inthe screen form Calculation of the motor data, select Restore factory
setting and calculate motor data.

e Inthe screen form Summary do not activate the function RAM -> ROM, but
instead press the Finish button.
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7 Background information

7.3.4

STARTER - carrying out a motor identification routine

e After completing the quick commissioning, alarm A0541 (Motor data-
identification active) is displayed. Please carefully note that when starting the
motor identification routine current flows in the motor. For hanging (suspended)
axes the load must always be supported.

e To start the motor data identification routine, in the Project Navigator select the
menu item Commissioning and activate by double clicking on Control panel.

[Sinenics_a1z0- G120 =] IEIE Heh |
| Assume contral priorityl l j ﬂ v F setpoint specification  mm— .'—. :
s: [ o fe - Hz 0% g 00 2= 200%
™| Enables DDS: l_lj l— Hz
Enables available [1] Drive ready
© " C0: Freq_ setpoint before RFG =l
Diagriostics Specified Actual
Output frequency: | 15_uu| 0.00 Hz 15.00 Hz
OM JOFF1
8 ON /0FF 2 e || ] I i 0 Act fikered frequency =l
ON /OFF 3
Pulse enable 0.00 Hz |
Riamp-function gen. enable
8 Ramp-funclion generator start T — 000 A
Setpoint enable
d Irvverter load 0o

e Press Assume control priority and carefully note the security/safety
information and instructions. Then activate Enables.

[SiNaMIcs G120 - G120 | |il@ Hep |

M‘ ﬂ. ﬂ f setpoint specification 1 . - - .|—‘ -
s [0 ':Hz 02 [ 00 x - 2003
[V Enables ops: [ 0 —T
C Enables avallable [1] Drive ready
" CO: Freq. setpaint before RFG j
e | Specified Actual
Output frequency: | D_UUl 0.00 Hz 0.00 Hz |
OM /OFF 1
i 0.00 0.00 M
8 ON /0OFF 2 CIL1= I I " CO: Act. filtered frequency j
ON /OFF 3
Pulse enable 0.00 Hz |
Ramp-function gen. enable
Famp-function generator start Molor current 0o A
Setpaint enable
d Inverter load: oo %

e 1)) If the Control panel isn't completely displayed on your PG/PC, then press
the &? button.

e The motor data identification routine is started by pressing the D button. Do
not exit the STARTER software and go to another task as otherwise the motor
data identification routine will be interrupted for safety reasons.

e Please wait until the D button changes back to the . button.

e Return the control priority to the S7 control by pressing the
Give up contral priarityl | button.
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7.3.5 STARTER - setting the Profinet communications

e Communications between the CPU and the SINAMICS G120 must then be
parameterized. To do this, open the screen for the communication settings
using Communication -> Profinet. Select the tab Transmit direction.

e To start, select the Standard-Telegram 350 (350) from Message frame: (1.).
This pre-assigns the telegram.

F“'STARTER - G120_STD_App_2 - [G120.SINAMICS_G120 - PROFINET]

ﬂ] Project Edit  Target system Wiew Options Window Help
| DisR% & £l=le] ol ]| =l s (m 0@ | || % |
T

=P G120_5TD_App_2

x
Receive direction  Transmit direction |

""" ] Insert single drive unit (Message frame: I[350] Standard Telegram 350 j-] 1 o
=flls G120
----- ) Configure drive unit ™ Suppress inactive interconnections
B[ SINAMICS_G120
----- »ﬁ- Drive navigator o)
----- » Configuration QJ\'
{5 Inputs/outputs
-3 Setpoint channel Z51 | 1
-3 Open-loopfclosed-loop contral
55 Functions NIST_& GLATT |[2]
B Messages and monitoring ,l 127 1 CO: Act. output curent IAIST_GLATT |i|
-3 Technology controller
-3 Commissioning |53 CO/BO: Act. status word 2 Z5w2
=¥ Communication p |3
» Interfaces F -
> PROFINET [ [5]
[ Diagnostics ,l 0%
) 1[5

e Then replace telegram 350 by telegram type Free BICO connection (999) (1.).
Deactivate any possibly active Suppress inactive interconnections function
(2.) and establish the following interconnections (3.):

e PZD 5 =r2131 (Last fault number code)
e PZD 6 =r2132 (First warning number code)

[&“"'STARTER - G120_STD_App_2 - [G120.5INAMICS_G120 - PROFINET]

ﬂ] Project Edit Target system Wiew Options ‘Window Help
| Dis(em] 2 &=l o= el | HE Il | ] | 0|@)]| 2[])% |
EIETN

x
Receive direction  Transmit direction I
=& 6120_5TD_dpp_2
é_,l Insert single drive unit (Message frarne: I[SSS] Free BICO connection =l ] 1.
G120
----- ® Configure drive unit (I_ Suppress inactive interconnections] 2
- SINAMICS_G120 :
----- »ﬁ- Drive navigator Q
----- » Configuration Qj\'
= Inputsfoutputs
[ ¥ Setpaint channel e ——
5 |52 CO/BO: At s 1
- ¥ Open-loop/clased-loop contral _l
B Functions ,l 121 : CO: Act. filkered frequency
[ Messages and monitoring |27 : CO: Act. output current
- ¥ Technology controller - - 7
B-% Commissioning | !rSS : CO/BO: Act. status word 2 4]
-3 Communication ,l 12131 : CO: Last fault number code | 5 3
> Interfaces —_— - =] o
S g ,l 12132 : CO: First warning number c é
[#- ¥ Diagnostics ,I [I%4 7]
) ([
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7 Background information

e Finally, you only have to save the SINAMICS G120 configured software in the
ROM memory of the drive inverter. To do this in the Project Navigator select
the menu item SINAMICS_G120

e In the function bar press the |3| button.
e Please wait until the download operation has been completed.
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8 Appendix

8

8.1

8.2

Appendix

Internet link data

Subject area

Title

Link to safety items

http://support.automation.siemens.com/WW/view/
en/20810941

SINAMICS G120
Documentation

http://support.automation.siemens.com/WW/view/
en/22339653/133300

Siemens customer
support homepage

Customer Support

SINAMICS G120

http://www.automation.siemens.com/mcms/standa

Homepage rd-drives/en/low-voltage-inverter/sinamics-
g120/Pages/sinamics-g120.aspx
History
Version Datum Change
V1.0 July 2010 First edition
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